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The information described in this document is the exclusive intellectual property of
Nuvoton Technology Corporation and shall not be reproduced without permission from Nuvoton.

Nuvoton is providing this document only for reference purposes of NO9H30 microcontroller based system design. Nuvoton
assumes no responsibility for errors or omissions.

All data and specifications are subject to change without notice.

For additional information or questions, please contact: Nuvoton Technology Corporation.

Sep. 23, 2025 Rev. 1.32



N9H30 Non-OS BSP {& Fj F-i

NUVOTON
I e e

NE

1 NOH30 NON-0S BSP /1 veiiiiiiiiinieeesiiiiiissseeesssisiissssseessssssssssssesssssnnnnnns 3
1.1 (ST I 2055 3
1.2 ol [ ol 5102 4
1.3 Eclipse BHZEFEIE (2025-00 FEASLL ) tririiiriiiie et e e et e e s e e eaeeneas 17
1.4 e T = A 28

2 3] A AN S, 29
2.1 [ E Sy el 2 oY 29
2.2 (1N T O 1T 3] 27 S S 29

3 N A 0= 30

4 T N 31

Spe. 23, 2025 2 of 32 Rev. 1.32



N9H30 Non-OS BSP {& Fj F-i

NUVOTON
I e e

1 N9H30 Non-OS BSP f/
728 BSP S FF TNOH30 £ 51 . #HERHEHY NOH30 2515 H &L ARM926EIS 71%1‘%[)13’\]
LEMEH . HE T 16kB I-Cache LK, 16kB D-Cache LLERMMU =CEESEHEIN, s
FRE] 300MHz HUBEER, W HE2AE T B E 05 OB, HUSB Hh#EHost/Device, SDHC 53
F&TFT LCD/ A, %mzs audio/ A, A 11 4HUART---Z&. W 0] LA NAND flash, SPI Flash Faf.
154, Non-OS BSP &1& T LU AA:

NOH30 Non-OS B&#h2 =,

U-Boot B {&AE, LUK NOH30 {5 F AV ERENF2 =

Windows W EEs#FE I Nu-Writer, LUK FR 2B AV ERE))

s BA SR

1.1 Keil GE3ERE

Non-OS BSP &] LA{# F Keil IDE BREERrEE. (HEHY ICE AE 8% 1 ULINK2. B BRI R
WABARARAXHGENNEEHE. FEFZMEHSRHE, TLLE Kel WE J7 4915k
http://www.keil.com/ §3’7

NOH30 % #&J-TAG 7. (#FHAZE A ICE &t I-TAG /i NEFEE] RAM 755,
{HENOH30 £ L&, J-TAG /rHE/ERIFANY, FrIEEE NOH30 HriE A USB Bz, i A
NuWriter 217 # 43 DA1%, & B2 NOH30 REN Z e, W B R hsiT#E R
SPI/NAND/eMMC HYF£=X. NOH30 1Y J-TAG ﬁzﬁ{%ﬂ% 3 E, ICE Reset W/ERAEA, & HI
J-TAG X &g & F#iREEA. DU T2 ULINK?2 EEEA Reset HY5%

ARM Target Driver Setup X
ULINK USB - JTAG Adapter JTAG Device Chain
T IDCODE Device Name IR len
TDO | @ 0x07926FOF ARM926EJ-SCore 4 |
ULINK Version: |ULINK2 |
Device Family: |ARM oI
Fimware Version: |V2‘U3 (¢ Automatic Detection |
M | Configurati
Max JTAG Clock: [1MHz v | S origuEten |
[T UsenTRST | | | |
Debug
Cache Options Download Options Misc Options
[¥ Cache Code [~ Verify Code Download [ Use Reset at Startup
[ Cache Memory ™ Download to Aash
o | _coes |
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J-Link A5 {DIAYECE, LU N2 REFA J-Link Reset AYJT .

ILink/)Trace Interface Driver Setup *
JTAG Speed: Debug Cache Options: jTrace Trace Options:
" Auto Selection [¥ Cache Code [ Enable Trace
" Adaptive Clocking v Cache Memary u
f* kHz: Max. Trace Samples:
1000 - B4K '
Reset Strateqy: Infa
|Nl:| Resst j M
==
QK | Cancel | ’Tlpl

NOH30 Non-OS BSP Y loader R Linux BSP {7 —F&AHM[ERYFE loader, U-Boot. U-Boot FY
BAESIRIEEAE Linux 487, HEAREK, 1f MEE NOH30 Linux BSP, 2% NIH30
Linux BSP BV MR ZLa5 RS EREE. S n DLE B A BSP #H CL& TR e dm s - 1Yk
1THE. B2 &M SPIeMMC R, 7TDAA R loader, HFEETT EAEZX. (HAE NAND boot
W, 5% BRI, BVpRH, 2 A U-Boot FEf#4.

1.2 Eclipse Bi&IRE

NOH30 BSP t37#% Eclipse FHZEIRIE. AGH#E /M 48 clipse My 2450 8. 5%, {43 ZEclipse

B 48uhhttps://www.eclipse.org/downloads/ N #;Eclipse IDE for C/C++ Developers Tool Fi&E T

H, B FHE 2 24 AL TTHIRRAR, ZRiMEclipse EHIAF Java runtime environment(JRE) T,

AT DARAEZE Java 4805 NEE JREEIDK 2248,

& https://github.com/xpack-dev-tools/windows-build-tools-xpack/releases | # 4mfE T. H - 584
“GNU MCU Eclipse Windows Build Tools v2.12 20190422” -+ #R#& &k “gnu-mcu-eclipse-

windows-build-tools-2.12-20190422-1053-win64.zip” » W ER4EEIAM C:\eclipse HEE | -

& https://developer.arm.com/downloads/-/gnu-rm F#EKGCC T E.§# - 3%$E  “gcc-arm-none-eabi-

10.3-2021.10-win32.zip” NEK > MERGEEIASM C:\eclipse HEE T -

XX 4% 2 T.H - GNU ARM Embedded Toolchain ] DL f& 4§  https://gnu-mcu-

eclipse.github.io/plugins/install/ & e

wi%, 228550 _FiltiEg %, T Eclipse #E ABAZE7 M HIT%, B Help -> Eclipse Marketplace.
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File Edit Source Refactor Mavigate Search Project Run Window iHeIp

@ ‘——— VHNO Launch Configurations € Welcome v & v @
@vE‘Q|4}5%@v€3vlﬁv@v#VOVQEVQV(DHE"DCOHTEHTS
¥ Search -Access | B | (&
Show Contextual Help :
ByPr. ® §Co. — O . L ) Bz 2 = O
Show Active Keybindings... Ctrl+5Shift+L
= <===:>| ¢ & . - RN |
o ~ Tips and Tricks...
= CRIEI0HES & Report Bug or Enhancement..
ETIMER_EventCounter Cheat Sheets...
3 ETIMER_FreeCounting - -
J ETIMER Perodic @ Eclipse User Storage | Open the Eclipse Marketplace mzard]
» & ETIMER ToggleOut % Perform Setup Tasks..
% Check for Updates
g Install New Software...
& Eclipse Marketplace... I
rduino Downloads Manager
@ Arduino D loads Manag
< About Eclipse IDE
Contribute
2! Problems ¥ Tasks B Conscle 2 Properties #BE~Ov=0O

Mo consoles to display at this time.

TEFind #7865 A gnu meu eclipse, TS 45BN TN 7105, [ &5 H aras A WH2 T~
Installfz 22585, #RAHREplug inEH(GNU MCU C/C++).
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Eclipse Marketplace

Select solutions to install. Press Install Now to proceed with installation.
Press the "mare info” link to learn more about a solution.

Searchl Recent| Popular| Favorites| Installed | ', Giving leT an Edge

Find: |2 meu eclipsd x | | All Markets ~ | | All Categories v Go

Eclipse Embedded C/C++ 6.2.2

The Eclipse Embedded COT (C/C++ Development Tools, formerly GMU
MCU/ARM Eclipse] is an open source project that includes a family of
Eclipse plug-ins and tools... more info

by Liviu lonescu, EPL
GNU Arm Cortex-M RISC-V J-Link

*?_19 #% | Installs: 153K (729 last month) Installed

Notepadde 1.5.3

Create highly customisable notes in Eclipse and never lose track of your
thoughts, ideas or code snippets! more info

I by Pierre-Yves Bigourdan, EPL 2.0
notepad memo note notes lists

*?‘J #% | Installs: 8.51K (71 last month) Install

EmbSysRegView 0.2.6

EMEedded 5Y5tems REGister VIEW is an Eclipse Plugin which is designed

m for meonitoring and modifying memery values of embedded devices.
Therefore it offers a... more info

by Missing name Mising name, EPL
EmbSysRegView memory memory view memory values memory
menitoring

. .

Marketplaces

=

® < Back Install Mow > Einish Cancel

Eclipse 38 H 54N 2 EECDT A e 2 #FC/IC++ A 88 f2 2, fEEclipse MYFH %) - B53%Help >
Install New Software.
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£ temp - Eclipse IDE — E‘M
File Edit Source Refactor Mavigate Search Project Run Window iHeIp]
@ |——— V||No Launch Configurations € Welcome t v & v &
@va‘@\|@%@v g% - Iﬁv @v?@:v ngquv ® HeIpCOntents
¥ Search Access % | |E=)
Show Contextual Help '
E5Pr. 8|2 Co. — O ) o ) w2 = 0
P Show Active Keybindings... Ctrl+5Shift+L
ERAK & Tips and Tricks.. i
& & Report Bug or Enhancement... -
ETIMER_EventCounter Cheat Sheets... =5 ETIMER Toggle
3 ETIMER_FreeCounting ;
3 ETIMER_Perodic ? Eclipse User Storage 4
» &2 ETIMER_ ToggleOut % Perform Setup Tasks...
%o Check for Updates
= Install New Sof‘tware...l
7 Eclipse Marketplace...
@ Arduino Downloads Manager
< About Eclipse IDE
Contribute
?! Problems ¥ Tasks & Console 3 [ Properties #BE-Oy=0O
Mo consoles to display at this time.
< [T »
0 items selected

1Ework withff iz ACDT.
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= Install o x
Available Software
Check the items that you wish to install, -9 =
.
Work with: | CDT - https://download.eclipse.org/toels/ cdt/releases/|atest v Add... Manage...
[type filter text Select All
Name Version L) Deselect All

» [#]000 CDT Main Features

> 00 COT Optional Features
» [J000 JSOM CDB Extras

> [J000 LaunchBar

> [JU00 Remote Services

» []000 Remote Services SDK
» []000 Terminal Features

» []000 Terminal SDK Features W

48 items selected

Details
Show only the latest versions of available software Hide iterns that are already installed
Group items by category What is already installed?

[ Show only software applicable to target environment

Contact all update sites during install to find required software

@ < Back Next > el Cancel

TN 1R EFEETCDT Main FeaturesfICDT Optional Features, {§ & 0] LARIEZE K )5 HETHYE
2P EE B s AL o
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Available Software

S

Check the items that you wish to install.

- Add.. ] [ Manage... ]

Work with:n CDT - http://download.eclipse.org/tools/cdt/releases/9.5]

type filter text Select All
Name Version Deselect All

- [Z] 000 CDT Main Features

- [C] 000 CDT Optional Features
I- [C] 000 LaunchBar

i+ [ 000 Uncategorized

Details
CDT Main Features 1.0.0.7Z27177cLSvwwE7ETACTYAcAAMA -
Show only the latest versions of available software [T Hide items that are already installed
Group items by category What is already installed?

["] Show only software applicable to target environment

Contact all update sites during install to find required software

® < Back Next = Finish

1E285 CDT Z1% » EEEY Eclipse « FEE %€ T B8 > {ERiTE 5 248 T sk FRYE 2 A
c:\eclipse FEIE R o {F Eclipse F#EEE  “Windows” = “Preferences” BEEX preference fR% °
IRIBIEFE “MCU” = “Global Arm Toolchains Paths” > ZR{ZEEFERLIR  “C:\eclipse\gce-
arm-none-eabi-10.3-2021.10\bin”  ©
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& Preferences O X
type filter text Global Arm Toolchains Paths CR VS
General . Cenfigure the locations where various GNU Arm toolchains are installed. The
C/Cr+ wvalues are stored within Eclipse. Unless redefined more specifically, they are
Changelog used for all prejects in all workspaces.
EDF“” Default toolchain: | xPack GNU Arm Embedded GCC v
elp
Install/Update Toalchain name:  [GNU MCU Eclipse ARM Embedded GCC
Language Servers Toolchain folder:  |3bi-10.3-2021.100\bin Browse... xPack...
Library Hover
v MCU

Global Arm Toolchains Paths

Global Build Teols Path

Global OpenQCD Path

Global pyQCD Path

Global QEMU Path

Global RISC-V Toolchains Paths

Global SEGGER J-Link Path

Workspace Arm Toolchains Pat

Workspace Build Tools Path

Workspace OpenOCD Path

Workspace pyOCD Path

Workspace QEMU Path

Workspace RISC-V Toclchains F

Workspace SEGGER J-Link Path «
£ >

@ i3 i

Restore Defaults Apply

BEFEN HAY “Global Build Tools Path”  » G 3IEF B RELE “Cieclipse\GNU MCU
Eclipse\Build Tools\2.12-20190422-1053\bin”  °

2 Preferences o x

[typefitter text | | Global Build Tools Path Sro g

General ~

C/C++

Changelog

Docker

Help

Install/Update

Language Servers

Library Hover

v MCU
Global Arm Toolchains Paths
Global Build Tecls Path
Global OpenQCD Path
Global pyOCD Path
Global QEMU Path
Global RISC-V Teelchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Pat
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyOCD Path
Workspace QEMU Path
Workspace RISC-V Teclchains F
Workspace SEGGER J-Link Path w
< >

@ [ Apply and Close Cancel

The locations where various Eclipse Embedded COT build tools are installed. Unless defined more specifically, they are used for all
projects in all workspaces.

Build tools folder: |pse\ARMS Tools\GNU MCU Eclipse\Build Tools\2.12-20190422-1053\bin Browse... xPack..,

Restore Defaults Apply

FIAE Eclipse FBESFERZCASE BT » A LU#EFT NOH30BSP 45:% - 3 MAKEI DI F3HEEE File
=> Import Z£ A —{[# NOH30 #Hif|HZ -
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= Import
Select

Create new projects from an archive file or directory. @

Select an import wizard:

|t}rpefilter text |

v [ General
& Archive File
=2 Existing Projects into Workspace
(=) File System
[T Preferences
(Z Projects from Folder or Archive
v = OfC++
[c] C/C++ Executable
& C/C++ Project Settings
Existing code as Autotools project
Existing Code as Makefile Project
» = Git
5 [= Install
» [= Oomph
(= RPI

@ < Back MNext = Finish Cancel

BIEEBERE GCC H% > Bi%  “Finish”

FHRIERZE - BRAE Eclipse fEZ Al LIGwaE NOH30 GCC
BHET -

Spe. 23, 2025 11 of 32 Rev. 1.32



N9H30 Non-OS BSP {& F§ F

NUVYOTONMN
*

= Import O x
Import Projects -
Select a directory to search for existing Eclipse projects. ; Af’

(®) Select root directory:  [3700Git\BSP\non-os\SampleCode\LCDVGCC | Browse...

() Select archive file: Browse...
Projects:
LCD (D:\Projects\ ARMSWNUCSTINGIt\BSP\non-os\SampleCode\LC Select All
Dezelect All
Refresh
< >
Options
[[] search for nested projects
[[] Copy projects into workspace
[[] Close newly imported projects upon completion
[ Hide projects that already exist in the workspace
Working sets
[]Add project to working sets Mew...
Warking sets: Select...

® < Back Mext = Cancel

Eclipse A[4&HC J-Link {585, 5 FHI-Link35 3% 3E5GNU MCU C/C++ J-Link Debugging E4:, %
FesE kg, A B/  ET%, BEEEWindows->Preference->MCU 2% %E]-Link Path , 2 E& T
N ApplyfEsHENI ] 5ERKT-Link Patha% iE.
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= Preferences o ks
type filter text Global SEGGER J-Link Path F - ~ 8
General ~

Configure the location where SEGGER J-Link is installed. The values are stored within

CiCer Eclipse. Unless redefined more specifically, they are used for all projects in all
Changelog workspaces.
Docker
Help After installing SEGGER updates, restart Eclipse for the defaults to be re-evaluated and
Install/Update use the Restore Defaults button to configure the new location.
Language Servers Executable: |JLinkGDEServerCL.exe
;bcflﬂjl}' Hover Folder: | C\Program Files\SEGGER\JLink ‘ E Browse... i xPack...
w

Global Arm Toolchains Paths
Global Build Tools Path
Global OpenOCD Path
Global pyQCD Path
Global QEMU Path
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Paths
‘Workspace Build Tools Path
‘Workspace OpenOCD Path
Woarkspace pyOCD Path
Workspace QEMU Path
‘Workspace RISC-V Toolchains Paths
Woaorkspace SEGGER J-Link Path

Oomph

Remote Development

RPM

Run/Debug

SWTChart Extensions

Terminal

TextMate

Tracing © Restore Defaults Apply

@ Dy e Apply and Close Cancel

BE TR, 8¢ Debug Configurations , £5H2& 7 _F%575ERun-> Debug Configurations , £ 75 B,
{Z4£GDB SEGGER J-Link Debugging #EIE F 1%/ K A5 |
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‘S Debug Configurations O x
Create, ge, and run fig
O e x| B 7T~ Configure launch settings from this dialog:
‘typef\\ter text | [ - Press the 'New Configuration' button to create a configuration of the selected type.
[E] C/C++ Application [f - Press the 'New Prototype’ button to create a launch configuration prototype of the selected type.

[E] C/C++ Attach to Applicatior
[E] C/C++ Container Launcher
[E] C/C++ Postrortem Debugg

C/C++ Remote Applicat
E cj:cH UETO ©APPUCAHON |1 82 - Press the 'Delete’ button to remave the selected configuration.
U ++ Unif

& - Press the 'Export’ button to export the selected configurations.

- Press the 'Duplicate’ button to copy the selected configuration.

[5] GDB Hardware Debugging || f - Press the ‘Filter' button to configure filtering options.
[T] GDB OpenOCD Debugging

(5] GDB PyOCD Deb - Edit or view an existing configuration by selecting it.
y ebugging
[T] GDB QEMU Debugging - Select launch configuration(s) and then select ‘Link Prototype’ menu item to link a prototype.
GDB SEGGER J-Link Debuggi
E L hG S [u] - Select launch configuration(s) and then select 'Unlink Prototype’ menu item to unlink a prototype.
aunch Group

- Select launch configuration(s) and then select ‘Reset with Prototype Values' menu item to reset with protatype values.

Configure launch perspective settings from the 'Perspectives’ preference page.

< >
Filter matched 12 of 12 items

® Debug Close
W B AW 77
BLEDebugger , AGHKIET
S Debug Configurations O x
Create, ge, and run fig!
CRERRXIEY | yme [LCD Release
pe filter Main Debugger| = Startup | 1 Source [] Common| &, SVD Path
type filter text g pl B o
[C] C/C++ Application J-Link GDB Server Setup “
E C/C++ Attach to Applicatior [ Start the J-Link GDB server locally [] Connect to running target
[E] C/C++ Container Launcher
ecutable path: ink_patl ink_gdbserver TOWSE... aniables...
[T] C/C++ Postmortem Debugg e G g fink_path}/S{jlink_gdb: ' B VT
[£] C/Ce+ Remote Application Actual executable: | C:\Program Files\SEGGERULink/JLinkGDBServerCL.exe |
ci
Ell] g'[{f;': Udmt Deb (to change it use the global or workspace preferences pages or the project properties page)
ardware Debugging
[£] GDE OpenOCD Debugging Device name: |ARM9 | Supported device names
ebuggin ndianness: ittle i
GDB PyOCD Debugging End @ Littl O Big
[] GDB QEMU Debugging Connection: @uss O [ | wSB serial or IP name/address)
GDB SEGGER J-Link Debuggi .
[5] LCD Release Interface: Oswp @ITAG:
g Launch Group Initial speed: O Auto (O Adaptive (®) Fixed
GDB port:
SWO port: Verify downloads Initialize registers on start
Telnet port: Local hostonly (] Silent
Log file: | Browse...
Other options: | -singlerun -strict -timeout 0 -nogui
Allocate console for the GDB server [] Allocate console for semihosting and SWO
GDB Client Setup v
< >
Revert Appl
Filter matched 13 of 13 items — EES

@
P T 2R B Startup , FEEHEIVELES S T

Close

W

\
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S Debug Configurations

Create, ge, and run fig

OEeR xl B Y~ Name: ‘LCDREEESE
|typef|ltertaxt

Main ‘%31 Debugger [ [= Startup} B Sour:a‘ ] Commeon | L SVD Pathl
[E] C/C++ Application Initialization Commands

[E] C/C++ Attach to Applicatior || || [7iniiai Reset and Fialf Type: | | Low speed: [1000 | kHz
[E] C/C++ Container Launcher

[E] C/C++ Postmortem Debugg JTAG/SWD Speed: ® Auto (O Adaptive () Fixed kHz

[T] C/C++ Remote Application Enable flash breakpoints

Cif C/Ce+ Unit
% Sgg g;’:ﬂ"gg%ﬁ“\?ggg“"ngg Enable SWO  CPUfreq: 0 Hz. SWO freq: 0 Hz. Part mask: | 0x1
[c] GDB PyOCD Debugging
[t] GDB QEMU Debugging
+ [E] GDB SEGGER J-Link Debuggi
[©] LCD Release
R Launch Group

Enable semihosting Console routed to: [ Telnet ] GDE client

Load Symbols and Executable
Load symbols
(®) Use project binary:  LCD.elf

(O Use file: Workspace... File System...
Symbols offset(he: | |
Load executable
(®) Use project binary:  LCD.elf
(O Use file: Workspace... File System...
PSP e Sy S I h
< >
Filter matched 13 of 13 items [ Apply

@ Close
Seh Bl E 1% BV R] T Debug {5 HI-Link {H #5.

R EE C BZEfEApY C++ B2 - H4L > 12 File = Import Z A —{f& Eclipse C B2 » A%

#E4%E convert C++ from File = New =»Convert to a C/C++ Project (Adds C/C++ Nature) ° ZR%B1F
B RS (P SE A BN TS ©
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& hello - Eclipse IDE
File Edit Source Refactor Navigate Search Project Run Window Help

New Alt+Shift+N > Arduino Project
Open File... Makefile Project with Existing Code
L. Open Projects from File System... C-"C_++ Project
Recent Files > = Project...
Convert to a C/C++ Autotools Project
Close Ctrl+W = :
) Convert to a C/C++ Project (Adds C/C++ Nature)
Close All Ctrl+Shift+W oo Sanles Felks
Save Ctrl+S ¥ Folder
Save As... [¢ Source File
Save All Ctrl+Shift+S 6 Header File
Revert [ File from Template
@ Class
Move...
& Task
1 Rename... F2
&1 Refresh 5 [ Bample..
Convert Line Delimiters To » 7 Other... Ctrl+N
Print... Ctrl+P
21 |mport...
i Export...
Properties Alt+Enter
Switch Workspace >
Restart
Exit
& Convert to a C/C++ Project O >

1

Convert to a C/C++ project

The wizard adds C/C++ Nature to the selected projects to enable C/C++ Tools Support for them.

Candidates for conversion:

Mz hello Select All

Deselect All

Convert to C or C++

Oc Project ®C++ Project
Project options

Specify project type

Project type: Toolchains:

= GNU Autotools -~ GNU Autotools Toolchain
= Executable
= Executable (XL UPC) W

Show project types and toolchains only if they are supported on the platform

2

Spe. 23, 2025 16 of 32 Rev. 1.32



N9H30 Non-OS BSP {& Fj F-i

NUVOTON
I e e

1.3 Eclipse BH&IREE (2025-09 fRALLE)
NOH30 BSP t.57#% Eclipse BAESIRIR » AHETRIM4H Eclipse BVZEEEE - Hob o (FHER
Eclipse B 77 48 ik https://www.eclipse.org/downloads/ & Eclipse IDE for Embedded C/C++
Developers Tool fAg¢ T H. » ZEfEEAESE 2% MALTTIIIRA » RT3 17HY Eclipse A EV/E
& Java > RIE N AR B ZE4E Java o

&  https://github.com/xpack-dev-tools/windows-build-tools-xpack/releases N #i4RfE T E - 5%
“GNU MCU Eclipse Windows Build Tools v2.12 20190422 > 2Ai& &k " gnu-mcu-eclipse-
windows-build-tools-2, 12-20190422-1053-win64.zip” > W ERKEE A C\eclipse HEE T ©

#¢ https://developer.arm.com/downloads/-/gnu-rm [ #E{GCC T E.§# - #E5E  “gcc-arm-none-eabi-
10.3-2021.10-win32.zip” Tk > AERYEEIAH C\eclipse HEE T ©

S24Ne] L% 8 Eclipse Marketplace =& Eclipse Install New Software @ B4 MEFE R 22855 A
1Y Eclipse £:HE F o £ Eclipse Marketplace %4 Eclipse Embedded CDT #M# o 25 HBh 5
Eclipse ThEEZE > Help > Eclipse Marketplace © 7% Find ##fir -#isi A GNU MCU Eclipse * {5 /%
EfE =4S R P SR A » JR1%BL#E Install 2755 > #25AHRE plug in B (GNU MCU
CIC++) °

= eclipse-workspace - Eclipse IDE = [m] *
File Edit Source Refactor Mavigate Search Project Run Window
mifhd | @'Q'_ﬁn =] Q| > @'ﬁﬁ'jl@iﬁl Welcome

M T e M | : (7 Help Contents g | i
P, w = O %’ Search = 8
=] % |?| @ § Show Context Help H

> s > hello (in GCC)
- Show Active Keybindings... Ctrleshiftel o't

Tips and Tricks...
Report Bug or Enhancement...

Cheat Sheets...

Perform Setup Tasks...

Check for Updates
Install Mew Software...
Eclipse Marketplace..j

About Eclipse IDE
Report a Problem

csofelec g @a

Sponsor

[8] Problems J=| Tasks B Console x [ Propert Contribute = (5]
X 4G HEEEE 22 -8-

COT Build Console [hello]
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& Edipse Marketplace (m} *

Eclipse Marketplace

Select solutions to install. Press Install Now to proceed with installation,
Press the "more info” link to learn more about a solution.

Search| Recent| Popular| Insta\led| - Research at the Eclipse

Find: /© GNUMCUEclipse x  All Markets ~ All Categories v | Go

Eclipse Embedded C/C++ 6.6.1

- The Eclipse Embedded COT (C/C++ Development Tools, formerly GNU
MCU/ARMEtnbsp;Eclipse) is an open source project that includes a family of
Eclipse plug-ins and... more info

by Liviu lonescu, EPL
GNU Arm Cortex-M RISC-V J-Link

239 #  Installs: 174K (311 last month) Installed

Marketplaces

® < Back Install Now = Finish Cancel

Eclipse 352 5542285 CDT A BESZ#F C/C++ BHZE 2= > 1F Eclipse MI5H %%/ - 2575 Help >
Install New Software °
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= eclipse-workspace - Eclipse IDE

File Edit Source Refactor Mavigate Search Project Run Window

mifhd | ® - Q oz Biw | i at v e l;g) Welcome
- - -~ e v| d (7)  Help Contents g | i

Bp.. x = 0O &7 Search = B8

BS T 8 Show Context Help & B

> % > hello (in GCC)
- Show Active Keybindings... CurbeshifteL T3t

Tips and Tricks...

Report Bug or Enhancement...
Cheat Sheets...

&t 20

%8  Perform Setup Tasks...

il

e

Check for Updates
Install New Soﬂ:ware.a
Eclipse Marketplace...

(&

L

About Eclipse IDE
Report a Problem

450

Sponsor

[8] Problems J£] Tasks B Console X [ Propert Contribute = (5]
X oG HEF&EE 22~

COT Build Console [hello]

1£ Work with iz A CDT > T?ﬁﬁ% 2Fo1s CDT Main Features A1 CDT Optional Features * {8
FAE B DRI SR AR H G [INE 285 B R 8288 - 274485 CDT 2 1% » 35 EERI Eclipse °
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= Install O H
Available Software
Check the iterms that you wish to install. \:‘)“--
Work with: | CDT - https://download.eclipse.org/tecls/cdt/releases/latest ~ Add... Manage...
type filter text Select All
Mame Version Deselect All

» (@ 000 CDT Main Features

> (@ 000 CDT Optional Features
» |_J 000 JSOM CDB Extras

» [J 000 LaunchBar

» [J 000 Remote Services

> [CJ 000 Remote Services SDK
» [J 000 Terminal Features

» |J 000 Terminal SDK Features
> [CJ 000 Uncategorized

28 items selected

Details
B Show only the latest versions of available software B Hide items that are already installed
B Group items by category What is already installed?

[_] Show only software applicable to target environment
@ Contact all update sites during install to find required software

® < Back Finish Cancel

B TRy - FRIE B A N EARBRAE R AR o\eclipse BETET o 1£ Eclipse 75
B8 Windows > Preferences BfAEY preference 1775 > 2815 MCU > Global Arm Toolchains
Paths @ 5% EFSE  “C:\eclipse\gcc-arm-none-eabi-10.3-2021.10\bin”  ©
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& Preferences O
type filter text Global Arm Toolchains Paths Grev E
» C/C++ ) . . . .
Configure the locations where various GNU Arm toolchains are installed. The valu
Changelog specifically, they are used for all projects in all workspaces,
P . they proj P
» Docker Only the toolchains in use by projects in the workspace are shown on this page.
Hel
z Injtzll,a‘Update Specify-toolchain paths for ir.1 use to.olchains
> Language Servers Toolchain used by the following projects: hello
5 Library Hover Toolchain name: |GMNU MCU Eclipse ARM Embedded GCC (arm-nene-eabi-gec)
~ MCU Toolchain folder: ﬁeclipse\gcc-arm—none—eabi—10.3-2021.10\bﬂ

[Global Arm Toolchains Paths |
Global Build Toels Path
Global OpenOCD Path
Global pyOCD Path Select the default toolchain to be used when creating new projects
Global QEMU Paths
Global RISC-V Toolchains Paths
Global SEGGER. J-Link Path
Workspace Arm Toelchains Paths
Workspace Build Tocls Path
Workspace OpenOCD Path
Workspace pyOCD Path
Workspace QEMU Paths
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path

> Mylyn

~ Oamnh

@ I'é] Iéj @ Apply and Close Cancel

On macO5 use Shift+ Cmd+"." to show the hidden folders while browsing the file

Default teolchain: xPack GNU Arm Embedded GCC (arm-nene-eabi-gcc)

5815 N 71V Global Build Tools Path » i8I EEFEFEF(ELE “Cileclipse\GNU MCU Eclipse\Build
Tools\2.12-20190422-1053\bin”™  °

]

type filter text Global Build Tools Path (=1 g - §
» CfC++

The locations where various Eclipse Embedded COT build tools are installed. Unless defined more specifical
Changelog for all projects in all workspaces.

Docker
Build toolsfolder:l Checlipse\GNU MCU Eclipse\Build Tools\2,12-20190422-1053\bin I Browse...

Help

Install/Update

Language Servers

Library Hover

~ MCU
Global Arm Toolchains Paths
Global OpenQOCD Path
Global pyOCD Path
Global QEMU Paths
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
Workspace Arm Teolchains Paths
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyOCD Path
Workspace QEMU Paths
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path Restore Defaults

> Mylyn =

“» Onmnh

® |'lr_.', I'_l£7.| @ Cancel
Spe. 23, 2025 21 of 32 Rev. 1.32
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FIAE Eclipse BBREC A ELTF - A LU#ETT NOH30 BSP 45E% - 3 K¢ T35 File > Import
2 A —{[E NOH30 #5552 » #54% General > Existing Project into Workspace * ZR1% Bh#5E Next °

= Impaort O >
Create new projects frem an archive file or directory. | g 4 E I

Select an import wizard:

~ [~ General
JE ArchiveFile
[‘@ Existing Projects into Workspag
[ File System
[T Preferences
[} Projects from Folder or Archive
» [= C/C++
3 = Git
3 [= Install
» = Oomph
> [= RPM
» [= Run/Debug
» [= Tasks
» [= Team
» [= TextMate
» [= Tracing
» [= XML

® < Back Finish Cancel

AIBEIEHE GCC B2 > BE%E Finish BB - BAE Eclipse AIDAGR:E NOH30 GCC HZE
T
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& Import O =
Import Projects =T
7
Select a directory to search for existing Eclipse projects, 4 Af'

© Select root directory: C:\NS‘HB'D_NonOSEmpleCDde\helID\GC_CJv| Browse...

() Select archive file: Browse...
Projects:
B helle (C:ANIHI0_MonOS\SampleCodethello\GCT) Select All
Deselect All
Refresh
Options

[] Search for nested projects

[l Copy projects into workspace

[C] Close newly imported projects upon completion
[_] Hide projects that already exist in the workspace

Working sets

[] Add project to working sets New...

Select...

® < Back Mext = Cancel

Eclipse RJ#&HC J-Link #E7T7EREE - EFBEREE ZRT - S50 E DA T 4guE N 4A8E T-Link -
FaE4 | https://www.segoer.com/downloads/jlink/ » ZFEE5ERK % » =48 Eclipse THEEFMC P EE
% Window > Preferences > MCU > Global SEGGER J-Link Path %7 J-Link PR » SR14BLEE

Apply 5EREE
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type filter text

General
C/C++
Changelog
Docker

W

Help

Install/Update

Language Servers

Library Hover

MCU
Global Arm Toolchains Paths
Global Build Tools Path
Global OpenOCD Path
Global pyOCD Path
Global QEMU Paths

PV RV RVIEVIEY

[ Global SEGGER J-Link Path |

Workspace Build Tools Path
Workspace OpenQOCD Path
Workspace pyOCD Path
Workspace QEMU Paths

> Mylyn

@ ®

Global RISC-V Toolchains Paths

Workspace Arm Toolchains Paths

Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path

a
Global SEGGER J-Link Path M v 8
Configure the location where SEGGER J-Link is installed. The values are stored within
Eclipse. Unless redefined more specifically, they are used for all projects in all workspaces.
After installing SEGGER updates, restart Eclipse for the defaults to be re-evaluated and use
the Restore Defaults button to configure the new location.
Executable:  JLinkGDBServerCl.exe
Folder: C\Program Files\SEGGER\JLink_V243 Browse... xPack...
Restore Defaults Apply
Apply and Close Cancel

PR

%7€ Debug Configurations ° fF5H#$/ 7 1H _F%5#E Run > Debug Configurations @ %2

Y5 EEUEAT GDB SEGGER J-Link Debugging #eI8 3/ I /E #

0 E @ ..|E|1_f'v

type filter text

[E] C/C++ Application

[T] C/C++ Attach to Application

[T] C/C++ Container Launcher

[€] C/C++ Postmortem Debugger

[€] C/C++ Remote Application

Cif C/C++ Unit

[£] GDB Hardware Debugging

[T] GDE OpenOCD Debugging

[©] GDB PyOCD Debugging

[£] GDB QEMU aarch64 Debugging

[t] GDB QEMU arm Debugging

[t] GDB QEMU gnuarmeclipse Debu

[] GDB QEMU riscv32 Debugging

% GDB QEMU riscvbd Debuggini
GDE SEGGER J-Link Debuggin

@ Launch Group

Filter matched 16 of 16 items

@

Create, manage, and run configurations

Configure launch settings from this dialog:
_<> - Press the 'Mew Configuration’ button to create a configuration of the selected type.
ﬁ - Press the 'Mew Prototype' button to create a launch configuration prototype of the selected type.
:3) - Press the 'Export’ button to export the selected configurations,
:=| - Press the 'Duplicate’ button to copy the selected configuration.
3 - Pressthe 'Delete’ button to remove the selected configuration.
l_f‘ - Press the 'Filter' button to configure filtering options.
|L| - Select launch configuration(s) and then select 'Link Prototype’ menu item to link a prototype.
|u| - Select launch configuration(s) and then select 'Unlink Prototype’ menu item to unlink a prototype.

- Select launch cenfiguration(s) and then select 'Reset ...totype Values' menu item to reset with prototype values.

Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the Perspectives’ preference page.

Debug Close

Spe. 23, 2025
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L35 Debugger @ WIE T EEEIE °

S Debug Configurations O X

Create, manage, and run configurations

=y 2 -
L1 IF 4] L= x| = ']_‘I" MName: hello Release

type filter text Main | %5 Debugger| = Startup| Bp Source| 5| Commonl Tz, SVD Path
[E] C/C++ Application J-Link GDB Server Setup
[E] C/C++ Attach to Applicatiol @ Start the J-Link GDB server locally [_] Connect to running target

[E] C/C++ Container Launcher
[E] C/C++ Postmortem Debuge

[E] C/C++ Remote Application Actual executable:  C:\Program Files\SEGGER\JLink_V848/ILinkGDBServerCL.exe
Cif C/C++ Unit

Executable path:  §{jlink_path}/5{jlink_gdbserver} Browse...  Variables...

(to change it use the global or workspace preferences pages or the project properties page)

[t] GDBE Hardware Debugging
[E] GDB OpenOCD Debugging Device name: ARMG Supported device names
[©] GDB PyQCD Debugging Endianness: O Little (D) Big
[c] GDB QEMU aarchtd Debugg Ceonnection: O Use (@]l (USE serial or IP name/address)
[©] GDB QEMU arm Debugging
[c] GDB QEMU gnuarmeclipse [ lisiaee O swp OJTAG
E GDB QEMU riscv32 Debuggi Initial speed: ) Auto OAdapti\.re O Fixed 1000 kHz
[c] GDB QEMU riscvfd Debuggi GDB port: 2331
« [E] GDB SEGGER J-Link Debuggi -
E helle Release SWO port: 2332 [ -] Verify downloads B8 Initialize registers on start
R Launch Group Telnet port: 2333 @ Local hostonly [ Silent
Log file: Browse..
Other eptions: -singlerun -strict -timeout 0 -nogui
Allocate console for the GDB server @ Allocate console for semihosting and SWO

GDE Client Setup

Revert Apply

Filter matched 17 of 17 items

®

P2 NACREEE Startup » FEHEHVEES S TE © SERPTARIER » B8 Apply (a0 4% -
> HfERE NOH30 FsEtEacE RiE USB Btk - I HELHF22 NuWriter LUE{T DDR 4]
a1k - SERCE AP ERI% - RS Debug BRG] J-Link #E{TEREE -
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= Debug Configurations O X

Create, manage, and run configurations

o By B2 -
(9 e B 2 X | = Mame: hello Release
type filter text Main |f§‘« Debugger| 3 Startupl E_/ Sourcel i=| Common| lj:'-l._ SVD Path
€] C/C++ Application Initialization Commands
[c] C/C++ Attach to Application @ Initial Reset and Halt  Type: Low speed: 1000 kHz
[E] C/C++ Container Launcher -
[C] C/C++ Postmortem Debugger JTAG/SWD Speed: O Auto (O Adaptive () Fixed kHz
[€] C/C++ Remote Application B Enable flash breakpoints
Cif C/C++ Unit B Enable semihosting  Console routed to: @ Telnet [ GDB client
[] GDB Hardware Debugging )
Enable SWO = 0 . ;0 . : 0
[£] GDB OpenOCD Debugging nable CPU freq Hz. SWO freq Hz. Port mask: 01

[£] GDB PyOCD Debugging a
[c] GDB QEMU aarchf4 Debugging
[] GDB QEMU arm Debugging

v
[T] GDB QEMU gnuarmeclipse Deb
[t] GDB QEMU riscv32 Debugging Load Symbols and Executable
% GDB QEMU riscvéd Debugging ® Load symbols
~ GDB SEGGER J-Link Debugging . .
U ct b : hello.elf
[c] hello Release s T RS
15 Launch Group () Use file: Workspace... File System...
Symbols offset (hex):
B Load executable
© Use project binary:  hello.elf
() Use file: Workspace... File System...
Executable offzet (hex):
Runtime Options
I RAM application (reload after each reset/restart)
Revert Apply

Filter matched 17 of 17 items

®

W 4ELT Eclipse THEITERAE - B C BBZEEEAEY C++ B2 - H5L > 1% File > Import & A —{[&
Eclipse C B£ZE » #R1% 7542 File > New > Convert to a C/C++ Project (Adds C/C++ Nature) - £71%
BLEEE Finish DL5¢E Al BB 2L -
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‘s eclipse-workspace - Eclipse IDE

File Edit Source Refactor Mavigate Search Project

Alt+Shift+N »

Open File...
[} Open Projects from File System...

Window Help
C/C++ Project
Project...

Convert to a C/C++ Autotools Project
Convertto a C/C++ Project (Adds C/C++ Nature) I

Source Folder

Recent Files »

1 0nexm=cefo R ¢

+Shift+ Folder
) Source File
. ) Header File
. File from Template
- Class
- Task
_ Example...
& | Refresh F5 Other... Ctrl+M
Convert Line Delimiters To »
e Import..
3 Export.
Properties Alt+Enter
Switch Workspace >
Restart
Exit
S Convertto a C/C++ Project O X

Convert to a C/C++ project »
The wizard adds C/C++ Mature to the selected projects to enable C/C++ Tools Support for them. @

Candidates for conversion:

@ = hello Select All

Deselect All

Convert to C or C++
() C Project © C++ Project

Project options

8 Specify project type

Project type: Toolchains:
[= GNU Autotools GMNU Autotools Toolchain
(= Executable

(= Shared Library
= Static Library
== Makefile project

B Show project types and toolchains only if they are supported on the platform

®
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14 BAEHGERE

NOH30 &5 EH A R BIHE, 714¢ SPL, NAND, eMMC B, =24 A USB ISP f5
. B E T PA[1:0] HY power on setting F2¢Hl]. 55275 Bl S8 ARV S 2RI A S AR FERY
NE.
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2 BSP A%

2.1 BSP H§FZERE
Non-OS BSP &1 & 1 VU{E H #%. 5 H VA SYIIE N5

H %278 A

BSP Hek NS T Non-OS BREIES, 56 =78k, DL fifE =
Documents BSP MHEE -

Images TEIC4R R4 U-Boot HiL 45,

Tools Windows _FHEERR T B DU SEENFE

2.2 Non-OS BSP &
BSP H#x ML FNA:

H #k4tE AR

Driver NOH30 (i &2 HEEFE . (EEREIFE Y APL 5RBHEE 22 1T
Document H$% MY NIH30 Non-OS BSP Driver Reference Guide.chm
&L

Library NOH30 {5 FH 8 e 5. FII41USB Host.

SampleCode SEENFH R BIFE

Script BE T Keil 4SRRI link script. AR B A sE S5 FH AIRAIA.

ThirdParty EE=JTHES, B TFATFES SU 24, AR LwlP BJETCP/IPH#%
B
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3 NuWriter
NuWriter T. ELEEE BIE &% USB ISPHEZ, ML GRS AEFRE S, $140 © SPI Flash,
NAND Flash, 52 eMMC. {8 5 =552 N9H30 NuWriter User Manual 324
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4 FRAESE
FRASE | HEA it
1.00 Jan. 31, 2018 W EEAE
1.01 Jul. 5, 2018 RESEEN
1.02 Dec. 24, 2018 RESEE:N
1.10 May 31, 2018 3k Eclipse B8 IRES
1.20 Mar. 7, 2022 % emWin
1.30 Aug. 8, 2022 BE T Eclipse B &R0 A
1.31 Dec. 16, 2022 i C/C++ B R IA
1.32 Sep. 23, 2025 BE T Eclipse Ba#8IRIEERBA (2025-09 AL |)
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Important Notice

Nuvoton Products are neither intended nor warranted for usage in systems or equipment, any
malfunction or failure of which may cause loss of human life, bodily injury or severe property damage.
Such applications are deemed, “Insecure Usage”.

Insecure usage includes, but is not limited to: equipment for surgical implementation, atomic energy
control instruments, airplane or spaceship instruments, the control or operation of dynamic, brake or
safety systems designed for vehicular use, traffic signal instruments, all types of safety devices, and
other applications intended to support or sustain life.

All Insecure Usage shall be made at customer’s risk, and in the event that third parties lay claims to
Nuvoton as a result of customer’s Insecure Usage, customer shall indemnify the damages and
liabilities thus incurred by Nuvoton

Flease note that all data and specifications are subject to change without notice.
All the trademarks of products and companies mentioned in this datasheet belong to their respective owners.
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